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ACGNJ HAS AUGUST ACTIVITIES!
While many of our meetings shut down for the
summer, others don't. Some of our Special Interest
Groups have meetings scheduled. Have you been
curious about one or more of the groups on the right,
but just haven't found the time to “drop in”? When
you're not “riding the wild surf” or “catching some
rays”, maybe you might consider attending a few.
Then, there's our annual Planning Meeting on
August 17th. In many ways, this can be considered
our most important public meeting of the year. You
want to affect the direction the club is taking? That's
where it happens. Have a great summer, full of fun,
adventure and relaxation; and computer stuff too!

REMEMBER THESE DATES:
July 16, 2012 was the nineteenth anniversary of
Slackware Linux, first released in 1993 by Patrick
Volkerding. Slackware is the oldest surviving Linux
distribution. (There are many Linux variants derived
from Slackware).
August 16, 2012 is the nineteenth anniversary of
Debian GNU/Linux, first released in 1993 by Ian
Murdock. Debian is the second oldest surviving
Linux distribution. (Ubuntu is based on Debian, as
are many other “flavors” of Linux).
September 27, 2012 will be the twenty-ninth
anniversary of GNU (GNU's Not Unix), first
announced in 1983 by Richard Stallman. This is the
true date of origin for the operating system that we
now call Linux. (In its name, Debian GNU/Linux
acknowledges its GNU “roots”. Slackware Linux,
like most others, does not).

ACGNJ Meetings
A summer schedule is even shakier than usual. For
the latest ACGNJ meeting news, please check the
ACGNJ Website (www.acgnj.org) before you leave.
Lunics (Linux/UNIX): Monday, Aug 6, 8:00 PM
Andreas Meyer (lunics (at) acgnj.org)
Java: (No meeting in August)
Mike Redlich (mike (at) redlich.net)
Mobile Devices: Wednesday, Aug 8, 7:30 PM
Brenda Bell (mobdevsig (at) acgnj.org )
Investing: Thursday, Aug 9, 8:00 PM
Jim Cooper (jim (at) thecoopers.org).
NJ Gamers: Friday, Aug 10, 6:00 PM
Gregg McCarthy (greggmajestic (at) gmail.com)
Planning Meeting: Friday, Aug 17, 7:00 PM
(Please see page 3 for further details).
Evan Williams (president (at) acgnj.org)
Lunics (Linux/UNIX): Monday, Sept 3, Canceled
Lunics (Linux/UNIX): (Because it's Labor Day)
The following do not hold meetings in the summer:
C/C++, Firefox, Hardware, Layman’s Forum, Main
Meeting, WebDev, Window Pains.
All meetings, unless otherwise noted, are at the Scotch
Plains Rescue Squad, 1916 Bartle Ave, Scotch Plains,
New Jersey. Directions and map on back page.

http://www.acgnj.org
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07076. ACGNJ, a non-profit educational
corporation, is an independent computer user
group. Opinions expressed herein are solely
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Inc. All rights reserved. Permission to
reprint with appropriate credit is hereby
given to non-profit organizations.
Submissions: Articles, reviews, cartoons,
illustrations. Most common formats are
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preferred. Always confirm. Date review and
include name of word processor used, your
name, address and phone and name, address
and phone of manufacturer, if available.
Tips for reviewers: Why does anyone need
it? Why did you like it or hate it? Ease (or
difficulty) of installation, learning and use.
Would you pay for it?
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TCF Will Return!

We've been informed that the 38th
Annual Trenton Computer Festival
will be held on Saturday, March 16th,
2013, from 9:00 AM until 5:00 PM
(The flea market opens at 8:00 AM,
rain or shine). As usual, it will be
located at The College of New Jersey
in Ewing, NJ. Once again, it will be a
one-day Festival, with compelling
talks and great presentations. We
hope to see you there!
In its honor, we are printing this
picture, which unfortunately had to
be bumped from earlier newsletters
this year. In it, Bob Hawes (on the
left) and his cousin (also named
Robert Hawes) are shown taking care
of the ACGNJ table at TCF 2012.
(Photo by Eric Haffler).

Please Come To Our Annual Planning Meeting!
You are invited to attend our Planning Meeting on
Friday, August 17th 2012 at 7PM where this year’s
slate of talks for the Main Meeting and hopefully
also for the bulk of the Window Pains meetings will
be established. The meeting will be a dinner meeting
at Scotch Plains Rescue Squad (SPRS), in Scotch
Plains, NJ. Please RSVP. We need to know how
many are coming!
Your price for admission is two topics of discussion
for one of the 20 meeting nights (Main and Window
Pains). It will be your responsibility, should your
topic win by a vote of those attending the planning
meeting, to make arrangements to either provide a
speaker or be the speaker yourself on the approved
topic the night that it will be scheduled. You will be
expected to host the meeting, meaning you will
provide introduction of the speaker and see to it that
the speaker gets whatever assistance he or she may
need to give the talk. The time for a talk should be
about 45 minutes to an hour plus a Q & A session.
Any topic beats none at all, so don’t think it has to
be rocket science level stuff. Actually, the simpler a
August 2012

topic, the better public appeal will probably be. This
is the single biggest thing you can do right now to
help the ACGNJ.
Guests are welcome as long as they join ACGNJ for
at least 2yrs. prior to or at the meeting.
Unfortunately the club has suffered a loss in active
membership because of frequent lack of scheduled
and announced topics of discussion listed in the
newsletter and on the web-site calendar. We must try
to make this a successful meeting so that we may get
the ACGNJ back to its previous status as a well
recognized and respected source of information for
the computer user.
Please mark your calendars, Friday, August 17th
2012 at 7PM and bring at least two topics for a
meeting night.. Please respond to both John Raff
(facilities (at) acgnj.org) and Evan Williams
(president (at) acgnj.org) ASAP so that we can get a
head count for final reservations at Scotch Plains
Rescue Squad (SPRS). For further information and
for the RSVP form, see:
http://www.acgnj.org//pm/pma.html
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Foreign Imports
(Part 1 of 2)
Bob Hawes, ACGNJ
So far in 2012, the subjects of my own articles have
been fairly evenly split between backup programs
and newsletter construction. Here's another one
about newsletters; and quite possibly it'll be the last
one, since it covers the only part of my current
monthly routine that I haven't mentioned before:
articles written by people who are not me. Although
a few arrive as RTF (Rich Text Format) files, the
vast majority of articles written by “outside” authors
come in as Microsoft Word DOC files. That could
cause a problem, since there was a bug in
OpenOffice.org involving DOC files; and I'm unsure
if LibreOffice (which I'm using pretty much all the
time now) fixed it completely.
Therefore, I've been taking extra precautions, “just in
case". First, I open all DOC files with AbiWord (my
“backup” word processor) instead of LibreOffice.
Then I immediately save them again as RTF files and
exit AbiWord. Essentially, I'm just using AbiWord as
a file converter, because I know for an absolute fact

that AbiWord doesn't have the DOC bug. (I will be
describing this bug in detail, but not right now.
Please be patient until we get to Appendix I below).
Next, I open all RTF files with LibreOffice, and
immediately save them again as ODT (Open
Document Text) files. Thus, we wind up with DOC
files (which will be avoided from now on as
“unclean”), RTF files (which will be kept as “start
from scratch” backups, in case I later do something
so catastrophic that it's beyond the power of Undo to
fix), and ODT files (which will become my “work”
files).
After that, I split my ODT files in two, because our
newsletter's page format pretty much always
requires that each article's header be given its own
separate text frame. The first file, called “<original
filename>.odt”, contains most of the article; but not
the header information. The second file, called
“<original filename> (header).odt”, contains just the
header information. Here's the general format that I

(Continued Above Right)

(Continued Below Left)

follow for most headers: The first line contains the
article's title (in Arial Bold 13 to 15 point type,
whichever fits best). The second line contains the
author's name and the club's name (in Times New
Roman Bold Italic 12 point type). The third line
contains the newsletter's name, the club's website
address, and (if given) the author's e-mail address
(also in Times New Roman Bold Italic 12). All of the
lines in the header are centered.
Technically, I'm not supposed to edit an article that's
already been edited by another newsletter editor; but
due to those aforementioned header conditions, plus
our paragraph separation and column justification
requirements (which we'll get to soon), I have to. So
while I'm at it, I look for a few other common (and
annoying) errors as well. The first thing I look for is
unwanted “hard returns” in the middle of a
paragraph. Now, I suppose that I could show the
LibreOffice control codes and hunt them down that
way; but there's a quicker and easier method. In
LibreOffice, I press Ctrl-a to select all of the text in
the article, and I press Ctrl-c to copy that text. Then,

I open a plain text editor, make sure that line
wrapping is turned off, and press Ctrl-v to paste that
text there. If I just see single text lines, each
separated by a single blank line, then everything is
OK.
Each single line is the start of a paragraph, most of
which is way off screen to the right, since the lines
are not being wrapped. The blank lines between the
single lines are the blank lines between the
paragraphs. Two lines without a blank line between
them signify an unwanted hard return. The first word
in the extra line is the word that comes immediately
after said return, so I don't have any trouble finding
and removing it. (More than two lines without blank
lines between them indicate more than one unwanted
return. The repair technique is the same. Each return
comes before the first word in each additional line).
Next, we come to the ONLY area where, in my
opinion, MS Word is still superior to LibreOffice:
Grammar
Checking. A few
years
ago,
OpenOffice.org changed its Spelling Checker to a
Spelling and Grammar Checker; but as far as I could
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Foreign Imports, continued
tell, they did that by simply adding the words “and
Grammar” to its name. I've never detected any
increase in function, either in OpenOffice.org Writer
then or in LibreOffice Writer now. Technically, what
I'm looking for are actually punctuation errors, but
the fact remains: Microsoft Office will automatically
detect them, while LibreOffice won't. I have to use
the Edit > Find & Replace function instead.
The errors that I search for are: two spaces in a row,
two commas in a row, two periods in a row, a space
followed by a comma, and a space followed by a
period. There are others that I could include; but
practically, you have to set a limit, and these five are
the ones that I've chosen to pursue. However, there
are legitimate uses for two of these configurations.
Two periods in a row might be part of an ellipsis
(…), signifying a pause or an omission; and a space
followed by a period could be part of a measurement
(such as .3 GB/sec). Personally, I'd write that as “0.3
GB/sec”; but I'm not the author here, so I leave any
of those the way they were. In actual practice, I've
most often found two spaces in a row (which I

always change to a single space). After that, I've
found unwanted hard returns (which I always
remove). I've hardly ever turned up any of those
other punctuation errors.
Now we come to matters of “look and feel”. First,
our newsletter uses Times New Roman as its body
text font. Most outside articles use something else
(often Arial). So after I've taken care of any
punctuation errors, I press Ctrl-a to select all of the
text in the article, and I use the LibreOffice dropdown boxes to change the font to Times New Roman
12. (I can use a smaller size than 12 if necessary, but
I try not to). Then I run my Spelling Checker on the
entire article, just in case. In my experience, there is
absolutely nothing that turns a reader off faster than
a misspelled word. Unfortunately, not everyone out
there agrees with me.
Following that, I highlight, italicize, and
disable/remove all hyperlinks. Usually, articles that
come in as DOC files don't have their links set in
advance. Since I can be almost completely certain
that the word processor I'm using is not the same as

(Continued Above Right)

(Continued Below Left)

whatever was used to create those articles, maybe
that's why. No matter the reason, that is the way that
I want it. So all I have to do is make sure that I don't
accidentally activate them as I change them all to
blue italics, the ACGNJ News default color/font
selection for hyperlinks. (Those links will later be
activated using my “wacky kludges”. However, we
won't get to those until next month in Part 2).
Next up is paragraph separation. To start, I select
only the first paragraph (by highlighting it). Then,
from the Menu Bar, I choose Format > Paragraph.
The window that pops up has seven tabs; but I'm
only interested in the first one: Indents & Spacing.
At the top, under Indent, there are three drop-arrow
boxes containing measurements: (Before text, After
text, and First line). I make sure that they're all set to
0.00 inches. Below that, under Spacing, there are
two more drop-arrow boxes containing measurements: (Above paragraph and Below paragraph). I
make sure that they're both also set to 0.00 inches.
Beneath that, under Line spacing, there's one final
drop-arrow box, which contains seven selections:

(Single, 1.5 lines, Double, Proportional, At least,
Leading, and Fixed). I make sure that it's set to
Single. Then, I click on the OK button to exit.
After that, I highlight all the other paragraphs in the
article (but not the first one). Then, I choose Format
> Paragraph again, and I make sure that everything
is set as before, except that I set Above paragraph to
0.04 inches. Following that, I delete every single
blank line in the article. This gives me an article
that's just about as short as possible, yet there are
still perceptible gaps between the paragraphs. If
necessary, I can make those gaps even smaller; but
usually, if I change them, I make some or even all of
them bigger, until I get the article to end exactly
where I want. (Actually, this explanation is an
oversimplification. There ARE instances, such as
lists, where I have to set Before text and/or Above
paragraph differently. However, those situations are
beyond the scope of this article).
Coming into the “home stretch”, I add the following
sentence to the end of the article (as a separate
paragraph, in italics as shown): “This article was
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Foreign Imports, continued
obtained with permission to reprint by non-profit or
other user groups, with credit given to the author, the
publication and the user group”. Finally, we come to
column justification. This is a matter of taste, and I
like the text in my newsletters to line up evenly on
both sides of their columns. So as my more or less
last act before moving an article from LibreOffie to
Scribus, I press Ctrl-a to select everything in the
article, and then I change the text setting from Align
Left (the default) to Justified. And that's it. Except
for minor tweaks that can only be made “after-thefact”, my outside articles are now ready to be
imported into my newsletter.
This seems to be as good a place as any to pack it in
until next month. So now, as promised, here's the
DOC bug:
Appendix I: Suspicious Characters
Each month, I send my brother a copy of the new
article that I've written for our latest issue. He's my
proof reader; and partly due to that fact, I ran into
this bug almost immediately when I first started
using OpenOffice.org as my primary word processor.

Although I did make him a home desktop computer
(on which I'd also installed OOo), he mostly used
the laptop provided by his job, which only had
Microsoft Office. So I had to convert my articles
into the MS Word 95 DOC format before I could
send them to him. (I picked the 95 version as the
“lowest common denominator” of all the myriad
Windows file variants).
I've tried to record an example of this problem
several times, with less than stellar results. For my
latest attempt, I modified a paragraph that I've used
several times before, about a Star Trek cliché.
Success at last! (Or maybe “Failure at last!” would
express my sentiments better). The following
illustrations are screen shots. (To make them as
small as possible, I used an image editor to cut out
lots of irrelevant details). Figure 1 is the original
(Continued Below Left)

(Continued Above Right)

paragraph, as it was typed into OpenOffice.org, and
Figure 2 is what it looked like when it was “Saved
As” a DOC file. After that, I would exit from OOo,
and e-mail the DOC file to my brother. Now we get
to the fun part.
In the past, my usual e-mail practice in this situation
had been to CC a copy to myself as well. That gave
me a version of the DOC file that had, in fact, been
transmitted over the Internet, which I could then
check for corruption. (This wouldn't absolutely
guarantee that my brother had received an
undamaged copy, but it would mean that my
outgoing file hadn't been corrupted. Besides, it was
the best I could do with what I had). Unfortunately,
the first time that I did this after I'd switched from
MS Word to OpenOffice.org, I did find damage.
Wacky oriental-looking characters had appeared.
(See Figure 3).
After I'd finished panicking, I did some
experimenting. First, I found that if I used OOo to
open my original DOC file (which hadn't been sent
out over the Internet), I got the same result. So I
Page 6
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Foreign Imports, continued
wasn't looking at transmission damage. Next, I
discovered that the file hadn't, in fact, been
corrupted at all. If I opened it with good old
AbiWord (or bad old MS Word), I saw the proper
letters, totally unchanged. As Strother Martin
(playing “the Captain”) said in the 1967 Paul
Newman movie Cool Hand Luke: “What we have
here is a failure to communicate”. OpenOffice.org
was somehow reading my file incorrectly, so it was
simply displaying the wrong characters. Only if that
file was saved again by OOo would those characters
actually be written to the hard disk. Then, the
corruption became real.
I also did some investigation of the characters
themselves. I noticed that the “open quote” character
and the character immediately following it had been
changed, but the “close quote” character and the
character immediately following it had simply
vanished. In the first, second, third and fifth
quotations in Figure 3, that following character was
a space, so two words now ran together; but in the
fourth quotation, it was a period, so the space that
followed the period was still there. Also, though you
can't tell from this screen shot, what looks like a

space after each pair of oriental-looking characters is
not a separate space. It seems to actually be a part of
the second character. Ultimately, I had to drop my
investigation and move on.
From that point forward, I opened any DOC files that
I got with AbiWord. After my switch to LibreOffice,
it seemed that this particular bug had finally been
fixed. (See Figure 4). However, shortly after I

Figure 4
became full-time newsletter Editor and began to
routinely open “foreign” DOC files with LibreOffice,
another oriental-looking character showed up.
(Unfortunately, I didn't take a screen shot of it at the
time. Excuse me while I kick myself). After that, I
adopted the Abiword-to-RTF routine that I described
above. So far, so good. See you next month.

Turn Your PC into a 3-D Game Machine
Vinny LaBash, Regular Columnist, Sarasota PCUG, Florida
Newsletter: Sarasota Monitor (www.spcug.org) labash (at) spcug.org
3-D has been around for almost as long as
photography. The general public’s first major
exposure to 3-D was the 1952 motion picture Bwana
Devil. It wasn’t the first 3-D movie, but it was the
first to be shot in color and receive wide exposure.
The film didn’t win any awards, but the novelty of 3D was a hit with big screen fans. People became
enamored with the illusion of depth for several
years, but the thrill eventually faded, and 3-D was
essentially gone from movies by 1960.
3-D was by no means dead; it bounced around
development labs for years until it was combined
with wide screen technology and ultimately merged
with the incredible IMAX experience. You're not
going to get IMAX on your PC, but you can get a
solid 3-D effect in most of your games with a little
effort and small expense. It might be fun too.
Several weeks ago I received an interesting email
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from Roy R. who is well aware of my fondness
toward high end games. He told me about a web site
that claimed to turn a PC into a platform that could
display most games in 3-D even if they were
designed for 2-D.
Since the process appeared both relatively
uncomplicated and inexpensive, the only thing to do
was to see if it really worked. The first thing was to
go on Amazon and eBay and search for a pair of two
color 3-D glasses. They can be red/blue or
yellow/blue. You could probably make a pair
yourself with colored cellophane. A few minutes of
searching came up with an acceptable pair of glasses
for $2.00. For that amount of money I almost didn’t
care if they worked or not. Whatever the outcome, it
certainly beat spending $200 for a 3-D hardware
accelerator, that much or more for a 3-D monitor,
and up to $200 for a pair of 3-D shutter glasses.

ACGNJ
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Turn Your PC into a 3-D Game Machine, continued
The next step is to go to http://iz3d.com. From there,
download the free driver for their unique 3-D
monitor. Here’s how it’s done.
Step 1: From the iz3d.com home page, click the Get
Software page
Step 2: From the dropdown menu, select Anaglyph.
Step 3: When the download screen appears, select
the Current version Download button.
Step 4: After the software has been downloaded to
your system, choose RUN to install the program.
Step 5: Follow the instructions on the dialog boxes
or simply select the defaults.
Step 6: On the setup dialog box be sure to check the
Run Control Center box. Accept whatever defaults
the process offers, and then click Finish.
Step 7: The Direct X dialog box will appear. In the
Output section select Anaglyph (free) and the
option matching the 3-D glasses you have. Click
Apply.
Step 8: Examine the selections under Direct X in the
left side of the dialog box.

Step 9: If you know what you’re doing, change
whatever is appropriate, otherwise close down the
dialog box by clicking on the red X in the top right
corner.
Install the driver on your machine.
Step 1: Close any open applications or browser
sessions.
Step 2: Go to your Downloads folder and look for a
file named iZ3DDriverSetup.1.12(4016).EXE. If the
numbers at the end of the file name are different,
don’t worry about it. All it means is that the driver
has been updated since I wrote this.
Step 3: Double click on the file name to begin the
installation process.
Step 4: You may get a Security Warning dialog box
stating that the publisher could not be verified. Click
the Run button.
Step 5: The Account Control dialog box may also
make an appearance. Give permission to continue.
Step 6: You will get several more dialog boxes.
Accept the defaults to continue.

(Continued Above Right)

(Continued Below Left)

Step 7: On the Select Destination Location dialog
box either accept the default location for the
installation files or choose another location. Click
Next.
Step 8: On the Select Components dialog box,
choose Full Installation from the drop down menu.
Step 9: Click Next on the Select Start Menu dialog
box.
Step 10: Click Install on the Ready to Install dialog
box.
Step 11: Accept the defaults on any dialog boxes that
may appear.
Step 12: Click Finish when the installation is
complete. See illustration above.
Step 13: On the DirectX dialog box select the
Anaglyph (free) and Red/Cyan or Yellow/Blue
depending on what kind of 3-D glasses you have.
Step 14: Click Apply.
Step 15: Close out the dialog box by clicking on the
red X in the upper right corner of the dialog box.
Load any of your DirectX games and you will see a

menu that will walk you through the steps to
initialize the 3-D settings of the game. You may have
to shift the focus by holding down the Shift key and
pressing the + or – key on the numeric keypad.
There are directions in the menu that refer to the
“Num” key. This is not the Num Lock key, but a
reference that the instruction refers to the numeric
keypad.
The process worked with Mass Effect and Mass
Effect 2, Call of Duty, Left for Dead, and World of
Warcraft, an online game. I couldn’t get it to work
with Fallout New Vegas, so there’s no guarantee it
will work with all of your games, but for $2 it’s
certainly worth a try.
3-D technology has changed and improved
considerably over the years, but one thing remains
constant. 3-D glasses still make you look like a dork.
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USB 3.0 - The Super-Speed Bus
Andrew Petrovic, Ottawa PC Users' Group, Canada
Newsletter: PC News (http://opcug.ca/public/index.htm) opcug-webmaster (at) opcug.ca
I thought that it would be a good idea to introduce to
you a new and upcoming development - the USB
(Universal Serial Bus) version 3.0, as this
technology will become mainstream in a fairly short
time.
USB version 1.0 was created in 1996, but was more
widely available in 1998 as version 1.1, superseded
by version 2.0 in 2000. Over the next few years this
will be replaced by version 3.0, already released and
now being used by some consumers.
A quick overview of USB
The reason that USB was created all those years ago
was in order to provide an interface for computers
and peripheral devices that was easy to set up and
use, as well as being low-priced. Actually, the USB
data protocols used are very complex, but fortunately
the USB controller chips take care of these details,
so users don't have to be concerned. USB is designed
to be 'Plug and Play' without the user having to set
up parameters such as interrupt requests, addressing,

etc. as well as not having to reboot the computer
after adding a peripheral.
In USB versions up to 2.0 there are only four wires
that are connected: power; ground; data - and data +.
An 'A'-type connector (rectangular) is usually found
on a computer interface or hub, and a 'B'-type
connector (square) is often found on the USB
peripheral; but there are various other 'mini' and
'micro' connector types as well. When we talk about
USB components, we call a peripheral that plugs in
to a computer port a 'device' and the port and
controller associated with the port on the computer
is called the 'host'.
Each device has a 'descriptor'. When a device is
connected to a computer, the descriptor tells the host
what kind of peripheral it is. From the product IDs it
provides, the computer then knows what type of
driver to load for that device. A driver is a small
piece of software that interfaces between a hardware
device and the operating system.

(Continued Above Right)

(Continued Below Left)

Other information passed to the computer includes
the device's power requirements; protocol settings;
etc. When a USB device is unplugged, the host
instructs the operating system to unload the driver
for that device.
As far as the user is concerned, the most important
element of the upgrades to the USB technology is
the increasing speed of data transfer. The following
table shows the differences in data transfer speed
between the versions. The theoretical speed quoted
by manufacturers would, in reality, not be possible to
achieve and is based upon operations that include
extra packet transfer overheads, as well as a few
other things. The real life actual maximum speed is
likely to be between 30% and 60% of the quoted
theoretical speed.
Version 1.1 had two speeds, 'Low' and 'Full'. Version
2.0 just bettered the 1.1 version 'Full' speed. (See
Figure A). Note the difference between Mbps
(Megabits per second) and MBps (Megabytes per
second). There are 8 bits in one byte, so when
comparing speeds take note of which terminology
you are using.
August 2012

Figure A
Limitations of USB 2.0
So if USB 3.0 is appearing on the market, it must be
because previous versions are not able to do the job.
Well, this is partly true. Version 2.0 will be able to
be used for quite a lot of devices for a while, but as
peripherals get faster and require faster interfaces, so
USB 3.0 will become more desirable to end users.
The sort of devices that are likely to require the
faster data transfer speeds are external USB disk
drives and components that deal with video.
It's not just speed that is a limit. Each USB 2.0 host
port can provide up to 1/2 Amp (500 mA) of current
to power a device that does not have its own
additional power supply. Often this is simply not
enough. Some external disk drives may require up to
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USB 3.0 - The Super-Speed Bus, continued
900 mA of startup current and that is why they are
often supplied with a 'Y' cable that plugs into two
USB ports in order to feed enough power (for those
portable drives that don't use an external power
supply).
USB 2.0 data only moves unidirectionally. In other
words, data can be sent to a device or from a device
but not both at the same time. This cuts down the
overall speed attainable.
Introducing USB 3.0
Whereas the upgrade from USB 1.1 to USB 2.0 used
the same connectors with the same four wires, the
upgrade from USB 2.0 to 3.0 is very much different.
Take the USB 2.0 configuration and add another
entire set of connectors to it and call it 'Super speed'.
This is how USB 3.0 has been created. The original
USB 2.0 wires are still in place and the USB 3.0
adds five more wires (two pairs of data wires and a
signal ground cable).
Figure B shows how a USB 3.0 'A'type looks (Female - Receptacle),
with pins 1 to 4 being identical to
Figure B
the original USB 2.0 specification.

Cables and connectors are backwards compatible as
well, so you can plug in a USB 2.0 device to a USB
3.0 port - you just won't get any extra speed
advantages because only the USB 2.0 connectors
will be used, though the power pins are the same so
more available current should be available for USB
2.0 devices.
How is USB 3.0 better?
Apart from being fully compatible with previous
USB versions, the faster data transfer is quite a
dramatic improvement for USB 3.0 compatible
devices because of a faster clock control speed; the
use of asynchronous signaling for simultaneous
sending and receiving; and an interrupt mechanism
that does not use the time-consuming polling that
USB 2.0 used.
One area where USB 3.0 may fall down is with the
length of the cable that can be used. It could be
limited to 3 meters if high throughput devices are
used, as compared to the 5 meter cables possible
with USB 2.0.
The limitation could be overcome using USB hubs
or extenders and perhaps fiber-optic cabling might

(Continued Above Right)

(Continued Below Left)

be possible in the future.
Is it worth upgrading?
USB 2.0 will likely be around for the next few years
anyway, but in time newer computer motherboards
will provide USB 3.0 ports as standard.
If you want to try out the technology now, there are
add-on adapters available that plug in to a spare PCIExpress slot on your PC and provide two or more
USB ports. There are also a few USB 3.0 external
disk drives available, as well as hard drive
enclosures with USB 3.0 interfaces where you can
put in your own internal drive.
If you only have slow devices on your USB
connections, it's no great advantage to upgrade. For
example, keyboards and mice only require the
slowest USB version and will not work any better on
faster USB ports.
If you must have the faster transfer speeds for
storage or video devices, then you should consider
some form of upgrade. There are alternate interface
types, such as eSATA and FireWire, but they are a
less common interface type than USB and they also

require a separate power line, as well as not always
being 'hot-swappable'.
Other things that will benefit from the USB 3.0
interfaces are card readers and connections from
digital cameras, when transferring pictures to the
PC, though not when you plug in the current 'slower'
devices. USB 3.0 thumb drives will be faster on a
USB 3.0 interface but the current USB 2.0 thumb
drives will be no faster on a USB 3.0 port.
Interestingly enough, USB 3.0 thumb drives will be
faster on existing USB 2.0 ports because the whole
USB 3.0 flash drives had to be redesigned with
faster chip access in order to take advantage of the
USB 3.0 port speed.
Later versions of Windows and Linux should
natively support USB 3.0 at some point. Windows
XP will not, but USB interface and peripheral
manufacturers should be able to supply suitable
drivers for XP systems.
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Too Scared to Buy Anything Online?
Lee Seidman, Vice President, Business Professional Microcomputer UG, CT
Newsletter: The Help Key (www.bpmug.org) Lseidman (at) yahoo.com
Lots of consumers find purchasing goods online
intimidating; news reports of identity theft, online
piracy, and privacy concerns only deteriorates
people’s confidence in buying things on the Internet.
Using free software tools combined with some
education and common sense is all one needs to
build to become a savvy and safe e-consumer.
The secure e-consumer first needs to recognize when
a web site represents a reputable merchant. Using
online reviews from epinions.com, bizrate.com,
resellerratings.com, or even just a search on Google
will help one gauge a vendor’s trustworthiness based
on the experiences of others. Peruse the commentary
and read what people say and how they rate their
transactions with that supplier; what may initially be
perceived as a negative review may be little more
than someone griping about something irrelevant or
inconsequential (like it was delivered a day later than
expected, which may be the responsibility of the
transporting service instead). If there appears to be a

pattern of complaints about a particular vendor, it is
sensible to take that into account before ordering
anything.

(Continued Above Right)

(Continued Below Left)

ACCOUNT ON THESE SITES, DO NOT USE THE
SAME PASSWORD AS YOU WOULD USE TO
ACCESS YOUR E-MAIL. The address bar will have

and certificates.
When it comes time to actually buy an item online, a
credit card offers the best peace of mind available.
Most of the major credit card companies offer “zero
liability protection” for unauthorized purchases (read
the fine lines carefully, MasterCard states on its web
site that one’s account must be “in good standing,”
the consumer “exercised reason- able care in
safeguarding” the card from unauthorized use, and
that there must not be more than two unauthorized
events reported in the past twelve months). While
the legal verbiage may present a chill, many issuers
offer temporary credit card numbers specifically for
use online (Citigroup calls their “Virtual Credit
Card” while Bank of America markets it as
“ShopSafe”). These temporary credit card numbers
expire quickly or have whatever transaction limit
you wish to assign. When it is time to purchase an
item from an online merchant, open another web
browser, log into your credit card issuer’s web site,
and look for the section to open the tool for a virtual
credit card.
This virtual card number appears and functions as an

changed to read https:// and a lock appeared in the
browser as well (at least with Internet Explorer).
Clicking on that lock reveals information about the
web site and its security.
This tells the consumer that this web site has been
verified as who they say they are and that the
connection is encrypted (we are no longer just
“window shopping”). VeriSign and a handful of
other similar companies are the Internet’s certificate
authorities (CA), which substantiate the identities of
companies on the web. By viewing the certificate
(which is how the web browser on your computer
knows to trust the web site it is displaying), you can
see its validity and when it expires. Once that
certificate expires, your web browser will alert you
that the site is no longer trusted as it once was (this
should rarely happen with the big-name sites). Note
that web sites that request any form of identification
(like logging into a webmail, bank, or paystub
account) or financial transaction should use https://
August 2012

In the above example, we are “window shopping” on
a popular technology vendor web site called
newegg.com. Pretend that the unseen address bar at
the top reads: http://www.newegg.com. This means
the site offers no security presently; no sensitive
information is being exchanged at this time.
When we decide on an item to procure, most web
sites (like newegg.com) will request for the
purchaser to sign in (some sites will offer an opt-out
area for this, but many do not). IF YOU CREATE AN
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Too Scared to Buy Anything Online? continued
authentic credit card to the vendor; its purpose is to
keep its use limited to that particular transaction and
to keep your actual credit card number a secret from
that vendor. If the virtual credit card is compromised
by an unscrupulous third party, it is not as much of
an intrusion into one’s financial existence as if the
actual credit card number was used (there is no need
to replace a credit card, change accounts, etc.) Using
this tool satisfies the card issuer’s requirement for

“exercising reasonable care in safeguarding” the
authentic credit number, limits the amount of uses it
can be tried (usually just once), and makes online
shopping less frightening. The web may present
dangers, but using your savvy skills and online tools
should take the fear out of shopping!

LXDE
Cal Esneault, President of the Cajun Clickers Computer Club, LA
(And leader of many Open Source Workshops & SIGs http://cccclinuxsig.pbwiki.com)
Newsletter: Cajun Clickers Computer News (www.clickers.org) ccnewsletter (at) cox.net
The Linux OS (Operating System) permits users to
select from many front-end desktop environments
(the interface software that controls mouse, touch
screen, icons, etc.). Popular interfaces such as
GNOME and KDE are powerful but can require
high system resources. LXDE (Lightweight X11
Desktop Environment) is a simpler approach more
suitable for netbooks, mobile devices, or older PC’s.

It is designed to be faster, more energy efficient, and
be a better fit for the future of “cloud” computing.
Since LXDE open-source software is based on Xwindows, the commonly used system and network
protocol that provides the basis for graphical user
interfaces (GUI’s), it can be used with all the popular
Linux and BSD distributions (distro’s) – Ubuntu,
Fedora, OpenSUSE, Debian, etc.

(Continued Above Right)

(Continued Below Left)

LXDE originated as PCMan in 2006 by Hong Jen
Yee with the file manager PCManFM as the first
component.
This community backed distro with OpenBox as the
window manager has risen rapidly in popularity.
In May 2011, Lubuntu (the Ubuntu derivative using
LXDE) was made an official Canonical distro and
has surpassed the KDE-based Kubuntu in active
downloads. On my system which has Ubuntu 11.04
as the main OS, I downloaded the LXDE desktop.
Note the traditional tree-and-branch menu system
arising from the bottom panel. This reminds me of
the older KDE 3.x family. There are no extra
“widgets” or desktop panels now common in current
KDE 4.x releases. Also, there are no side panels of
“tiles” and pop-out icons present in the newer Unity
or Gnome 3.x desktops. LXDE has a simple, clean
interface which should be comfortable for traditional
users, such as those familiar with Windows XP.
Since I also have Gnome 3.x and KDE 4.X programs
on my system, I have access to all of them through
LXDE. If you want to have a less sophisticated

system that runs on older equipment with minimum
software overhead, do a fresh install of a dedicated
LXDE distro.
For example, a Pentium II processor with 256 MB of
ram that was used for Windows 98 could work, or a
later 600 MHz Pentium III with 512 MB of ram
should run well. Several major distro’s provide a
wide choice for your selection. For instance, the
software provided by Lubuntu includes (among
many others):
GPicView (photo viewer)
Leafpad (text editor)
LXTerminal (command line access)
OpenBox (window manager)
PCManFM (file manager)
Most distro’s also have versions to work with their
latest versions. For example, Lubuntu 12.10 will be
offered as one of the versions to be released this
October. Check all this out at the LXDE.org website.
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SIG News
LUNICS (Linux/Unix)
Andreas Meyer (lunics@acgnj.org)
http://www.acgnj.org/groups/lunics.html

Java
Mike Redlich (mike@redlich.net)
http://www.redlich.net/javasig/javasig.html

LUNICS is a group for those who share an interest in
Unix and similar operating systems. While we do
quite a bit with Linux, we’ve also been known to
discuss Solaris and BSD as well. Recent meetings
have followed a Random Access format. See our
web page for further information. (We meet on the
first Monday of each month, at 8:00 PM).

This SIG covers beginner, intermediate, and
advanced level Java programming. Primary focus is
on developing useful/practical applets and
applications. (We meet on the second Tuesday of
each month, at 7:30 PM).

Main Meeting
Evan Williams (president@acgnj.org)
http://www.acgnj.org/groups/mainmeet.html
We meet on the first Friday of the month, at 8:00
PM. Each December, this meeting includes our
Annual Business Meeting and Officer Elections. No
meetings in July or August.
Layman’s Forum
Matt Skoda (som359@aol.com)
http://www.acgnj.org/groups/laymans.html
This SIG discusses issues of interest to novice users
or those planning to get started in computing. Watch
our Web page for updates and announcements. We
meet at the same time as the Hardware Workshop.
(On the second Monday of the month, at 8:00 PM).
No meetings in July and August.
Hardware Workshop
Mike Reagan (hardware@acgnj.org)
This group is dedicated to repairing, refurbishing
and/or recycling older computers. Ten people
attended the first meeting, so there is still a market
for this type of event. Although we looked at some
of the older equipment stored in he back room, most
of our time was spent in talking about ast
experiences and planning for the future. Hopefully,
we can establish a viable long-term schedule of
projects, and keep the interest of those who attended
this inaugural meeting. If you have a hardware
problem, bring it in and we can all help fix or
demolish it. (No guarantees either way.) We meet at
the same time as the Layman's Forum. (On the
second Monday of each month, at 8:00 PM).
August 2012

Mobile Devices
Brenda Bell (mobdevsig@acgnj.org)
The Mobile Devices SIG focuses largely on currentgeneration cellphones and smart phones (such as
Blackberry, Android, iPhone) which bridge the gap
between basic cell phones and traditional computers,
and how they can help you manage and organize
your life. Our membership ranges from those who
have recently acquired their first, basic cellphone to
those who develop applications for today’s modern
smart phones, iPods, and ultra-portable computers.
While we expect to spend much of our time
investigating the built-in features and specialized
applications available to modern smart phones, if
you bring your basic (or multimedia) cell phone,
iPod, or other mobile device with questions on how
to use it, where to find applications, or what features
they have, we are always happy to help! Meet and
greet and plan where this event goes. Bring all your
ideas, PDAs, fancy phones, etc. (We meet on the
second Wednesday of alternate months (we get the
even ones), at 7:30PM).
WebDev
Evan Williams (webdev@acgnj.org)
This SIG is an open forum for all Website
Development techniques and technologies, to
encourage study and development of web sites of all
kinds. All languages will be considered and
examined. The current project is a CMS for the club.
Anyone interested in starting a new project, come to
the meeting and announce/explain. Provide as much
detail as possible. WebDev should be an allencompasing development and examination forum
for all issues, applications, OS, languages and
systems one can use to build Websites. We currently
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SIG News, continued
have two web development language SIGs: .NET
and Java; but other languages and OS need to be
investigated, examined and tested; Windows, Linux,
UNIX, DEC, Vax, HP etc. Intel-PC, Motorola MAC etc. (We meet on the second Wednesday of
alternate months (we get the odd ones), at 7:30 PM).
Investment Software
Jim Cooper (jim@thecoopers.org)
http://www.acgnj.org/groups/sig_investment.html
The Investment SIG continues with presentations on
how to use analysis programs TC2000 and TCNet.
Large charts are presented on our pull down screen
and illustrate the application of computer scans and
formulas to find stocks for profitable investments.
Technical analysis determines buy points, sell points
and projected moves. Technical analysis can also be
used on fundamentals such as earnings, sales growth,
etc. We're no longer focusing on just Telechart. If
you are using (or interested in) Tradestation, eSignal,
VectorVest, or just in learning how to select and use
charting and technical analysis, come join us!! (We
meet on the second Thursday of the month, at 8 PM).

C/C++ Programming
Bruce Arnold (barnold@ieee.org)
http://acgnj.barnold.us/index.html
This is a forum for discussion of programming in
general, beginning and intermediate level C, C++, CWin programming, hardware, algorithms, and
operating
systems.
We
demonstrate
real
programming in a non-intimidating way, presenting
complete code for working programs in 3-5 sheets of
paper. (We meet on the third Tuesday of each month,
at 7:30 PM). No meetings in July or August.
Window Pains
John Raff (jraff@comcast.net)
http://www.acgnj.org/groups/winpains.html
Intended to provide members with Windows oriented
discussions, Microsoft and Linux style. Directed to
more technological level of attendee, but newbies are
welcomed. (We meet on the third Friday of the
month at 8:00 PM). No meetings in July or August.
37th Anniversary Newsletter CD Now On Sale

NJ Gamers
Gregg McCarthy (greggmajestic@gmail.com)
http://www.NJGamers.com
www.lanparty.com

Beta .12 Release.
$8.00, including
postage.

The Friday Night Frag starts at 6:00 PM on the
second Friday of each month, and keeps going until
12 Noon on Saturday - 18 hours for 5 bucks!
BYOC - Bring your own computer.
BYOF - Bring your own food.
And if you don't like sitting on metal folding chairs...
BYO chair!

Get yours today!

Back Issues Still Needed

Firefox
David McRitchie (firefox@acgnj.org).
This SIG is an open forum for all Firefox and
Mozilla techniques and technologies, to encourage
study and development of web sites of all kinds. All
browsers will be considered and examined. All
members and guests are invited to check out the
design concepts and voice their opinion. (We meet
on the third Monday of each month, at 7:30 PM).
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($7.00 if you
pick up a copy
at a meeting).

Our collection remains incomplete. Below is a
list of missing newsletters. Anyone who lends us
one of these (or supplies a good clear copy) will
receive the next CD as our thanks.
1975: #2 and #3 (dates uncertain).
1976: January.
1984: August.
1985: June, July, August, September.
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